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Powerpoint

Lesson 1 — New Presentation

1. When PowerPoint first opens, there are four choices on how to create a new presentation. You
can select AutoContent wizard, Template, Blank presentation or Open an existing
presentation. AutoContent wizard will create a presentation for you using your
specifications. Once you are finished, you need to substitute the text they have entered with
your own text. Template gives you the background and formating for the presentation, and a
Blank presentation begins with one blank slide. Open an existing presentation allowsyou
to open a persentation that has been previoudy saved.

2. Choose by clicking the bullet to the left of the option you would like to use. For now, select
Blank presentation and click OK.
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3. Inthenext screen, the computer asks you to choose an AutoLayout. The AutoL ayout defines
the type of dide you are going to insert in your new presentation. There are numerous types of
slides including bullet slides, organizational charts, and tables. For now, choose the blank
screen and click OK (see below).
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4. Your screen should now display a blank slide on which you can begin to enter text and
graphics.

5. Moveon to Lesson 2 which describes how to insert anew dide.

Inserting a New Slide
Lesson 2

Now that you have a blank presentation with one blank slide, let's add another dlide.

1. The main menu is located at the top of PowerPoint's screen (and shown below). Go
to the main menu and click the I nsert menu.

2. Move the cursor down to New Slide and click. Typing the letter M while holding
the Ctrl key down will also add aslide. Y ou may use either option.
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3. The AutoL ayout screen should appear. Choose the blank screen and click OK .
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4. A blank screen will appear.

Entering text into your presentation
Lesson 3
Part |

Now that you have a blank presentation with one slide, let's enter some text. There are
two ways to enter text: text box and word art.

Using the Text Box

The text box is the best option for larger text passages or text which needs to be edited
easily.
1. Go to the main menu and sdlect the insert menu. Under the Insert menu, choose text box.
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2. After you have choosen the text box option, press the cursor down where you would like the
text to appear, and hold the cusor down as you drag the text box longer. Make the box as long

asyou like.
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3. Typein whatever you wish. Now, you are ready to edit your text.
Editing Text

1. To edit this text, highlight it by dragging the mouse over it while holding down the mouse
button. The text should appear highlighted as shown below.
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2. Inthe main menu, select the format menu as shown below.
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3. Intheformat menu, select font.
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4. The font screen should appear (as shown below). Here, you can choose a font, style, size,
effect and color for your highlighted text. Under the Font menu, choose Arial Black as| have
highlighted below. You can choose this font by clicking on it. Once it has been choosen, it
will appear highlighted.
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5. Under Font style, choose Bold as | have highlighted above. The bold option will make the text
appear darker than any other option.

6. Once you have choosen the Font and Style (Arial Black and Bold), click OK.
7. Thetext should look different now. The text after this editing is shown below.
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8. In the main menu, go back to the format menu and select Font again. When the Font screen
appears, change the style to Italic rather than Bold.
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9. Under the Size menu, select 60. Since 60 is larger than our previous font size, the size of our
text will increase.

10. Once you have made your selections, click OK. Thetext should appear as shown below.

This is what
your text

' box should
look like.

|

11. Once more, go to the Font screen (under the Format menu select font). Under effects, select
the box next to Underline. A check should appear in it as shown below.
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12. Under Color, pressthe arrow (¥ ). Choose the color blue by clicking onit.

13. Once you have finished, click OK. The text should now look like this:
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14. Now, we can move on to adding WordArt.

Using WordArt

WordArt can be used to create interesting headings or flashy titles.

1. Under theinsert menu, select picture. In the submenu that appears, select WordArt.
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2. Select atype of WordArt. For this tutorial, choose the rainbow style as outlined in the picture
below. Once you have selected it, click OK.
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3. Inthe next screen, type in aword or short phrase. Click OK when you are finished. This is

Powe Poinf:

4. Now, you are ready to edit your WordArt.

Editing WordArt

|
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1. Double click on your WordArt to get back to the menu where you added your WordArt text.
Thisiswhere you can edit your WordArt.

2. To change the font size, click the arrow under the Size menu as shown below. From the menu
that appears, select the number 54. Now, your WordArt will have font size 54.
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3. Thebold option is represented by a letter B on the button face at the top of the screen. Select
this option. Y ou may also use theitalic option by clicking the | which is next to the B button.

4. Now, we can change the font to Bookman Old Style by pulling down the menu with the

arrow button (¥ ). Keep the mouse button down until you have Bookman Old Style, then
release the button.
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5. Onceyou have finished editing your WordArt, click OK.

6. You now have two types of text on your screen; text box and WordArt.
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This is what
your text
box should
look like.

7. Now that we have text, we can move on to the next lesson to insert and edit pictures.
Inserting and editing a picture
Lesson 4
Part |
Inserting a clipart:

1. Go up to the main menu and click the insert menu.

2. Under the insert menu, choose picture then clip art.
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3. Inthe Microsoft Clip Gallery (shown below) make sure the Clip Art tab is selected. Choose a
category from the left. Select Gestures.
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4. Now, you can select one of the graphics displayed on the screen. If you would like more
options, you can press the world icon. The computer will let you choose an icon from a
homepage it brings up. This option is only available if you are connected to the Internet and
have access to the web.

5. Once you have made your selection, click | nsert.
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6. Thegraphic should now appear on screen.

Inserting and editing a picture
Lesson 4

Part 11
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Editing a picture:

1. Click the right mouse button on the picture and a menu will appear. Select For mat Picture.

2. Inthe Format Picture screen, the Colors and Lines tab should be selected.

3. The Fill refers to the background behind the picture. Press the arrow (!) to bring down the
possible colors. Select acolor by clicking the mouse button on that color.
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4. Using the same technique, the line options can be changed. To the right of the word Color, the
text should say "No Line." Click the arrow (.!) and amenu will appear (as shown below).

5. Select acolor by clicking onit.
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6. You can aso change the type of line under the Dashed menu as shown below. Select the
second one down -- the "Round Dot."
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7. Next, the line style can be changed. Click the arrow (=) next to Style and choose 3 pt as
shown below.

8. Once you have made your selections, click OK.
Moving and Resizing
1. At this point, it is possible that your text and clip art appears as shown below. To move

graphics or text, click the object you want to move. While holding the button down, drag the
object to the desired location. Release the mouse button to compl ete the move.
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2. Try to move the clip art to the bottom-left corner of the screen using the procedure illustrated
in step one.

S i h

3. Toresize an object, move the cursor to the edge of the object that you want to change. A two-
headed cursor will appear.

4. While the cursor is atwo-headed arrow, hold the left mouse button down and drag the cursor
tothedesired size.

5. Now that we can move and resize objects, we can move on to the next lesson -- animation.

cours ug 2000-2001.doc page 103



Nasri Messarra
Université Saint-Joseph
lundi 3 novembre 2003

Adding Animation
Lesson 5
Part |

1. Inthe main menu, click Slide Show.

2. Under the Slide Show menu, click Custom Animation as highlighted below.
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3. The Custom Animation screen should appear. Click the Timing tab if it is not already
selected.

4. Under the section Slide objects without animation, click WordArt. WordArt is shown
highlighted below.
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6. Under Animation order, you can see WordArt listed as nhumber one. This is the only item
being animated, so it is listed as the first item in the animation order. Use the arrows to set
animation order.

Adding Animation
Lesson 5
Part 11
1. Change the tab to the Effects tab.
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2. Under Entry animation and sound, click the first down arrow =as
shown above. Click Spiral.

3. In the second section under Entry animation and sound, click the
down arrow. From the list that appears click Drive By.
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4. Under the After animation section, click the down arrow button =.
Click Hide After Animation.
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5. Click Preview to see what the animation will do to your WordArt.

6. Onceyou are finished, click OK.

7. Note with PowerPoint XP, the on exit animation is available.

Adding Sound
Lesson 6
Part |
Inserting Sound

1. Inthemain menu, click | nsert.

2. Under the lnsert menu, click M ovies and Sounds as highlighted below.
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3. The Movies and Sounds submenu should appear. Click Sound from File as highlighted
below.

Play L0 Aixdo Track. .
Em:rd's-y.m

4. The Insert Sound screen appears. If you are not aready in the Media folder, click the down
arrow button (=) which islocated to the right of the text L ook in.
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5. In the C drive, go to the Windows directory and click the Media folder. The screen should
look like the one displayed above.
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6. There are two different ways to select afile. You may double-click Jungle M aximize.wav or
you may type the name in the box next to File name and click OK. | suggest simply double-
clicking Jungle Maximize.wav as highlighted below because it requires less steps. You can
tell that Jungle Maximize.wav is a sound file because it ends with .wav. There are three types
of sound files you can use in PowerPoint: .midi, .rmi and .wav.
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7. After you have double-clicked Jungle Maximizewav, a sound icon should in the center of
your screen. Theicon is shown circled in black below. Y ou can double-click the sound icon to
hear the sound.

Adding Sound
Lesson 6
Part 11
Animating Sound

1. Click on the Sound icon. Continue to hold the mouse button down
and drag the icon to the botton right corner of the screen. Now, the
icon is not blocking any words or graphics.

cours ug 2000-2001.doc page 110



Nasri Messarra
Université Saint-Joseph
lundi 3 novembre 2003

This is what
your text
box should

look like. Poie Point

2. Click the sound icon using the right mouse button. A menu should
appear as shown below. Click Custom Animation.
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3. The Custom Animation screen should appear. Make sure the Play
Settingstab is selected. The tab isboxed in red below.
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4. Click the box to the left of Play using animation order. This option
will alow your sound to begin after the other objects are animated
because it is currently last in the animation order.

5. Onceyou arefinished, click OK.
Adding Video
Lesson 7
Part |
Inserting Video
1. Inthemain menu, click | nsert.
2. Under the Insert menu, click Movies and Sounds as highlighted below.
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3. The Movies and Sounds submenu should appear. Click Movie from File as highlighted
below.
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4. The Insert Movie screen appears. If you are not aready in the Help folder, click the down
arrow button (=) which islocated to the right of the text L ook in.
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5. Inthe C drive, go to the Windows directory and click the Help folder. The screen should look
like the one displayed above.

6. There are two different ways to select afile. You may double-click Whatson.avi or you may
type the name in the box next to File name and click OK. | suggest simply double-clicking
Whatson.avi as highlighted below because it requires less steps.
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7. After you have double-clicked Whatson.avi, a movie icon should appear in the center of your
screen. Theicon is shown below. Y ou can double-click the movie icon to see the movie.

This is what
your text

Point
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Inserting a chart
Lesson 8
Part |

There are two different ways to insert achart. Y ou can insert object or insert chart.
Using the Insert Chart command requires less steps, but the object command is
necessary to import a spreadsheet or graph from another program into a PowerPoint
document. After the chart has been inserted, it can be edited the same way.

Insert chart:

1. Inthemain menu, click the |nsert menu.
2. Click New Slide. Thiswill allow the chart we will insert to be on a page by itself.
3. Select Blank Page and click OK.

4. Under thelnsert menu, click Chart.
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5. A chart and data sheet should appear.
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6. Enter datain the Datasheet. Replace their data with numbers and labels of your own. You are
welcome to add an extra column or row of dataif you would like.
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7. Once you have entered the data, click the close box [ on the Datasheet screen. This will
close your spreadsheet.
Inserting a chart
Lesson 8
Part 1
Insert object:

1. Using a new dlide, we can insert a chart using the insert object command. Under the insert
menu, choose Object.

2. TheInsert Object screen will appear. Select the bullet next to Create new. This will allow us
to create anew graph rather than using previously saved data.
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3. Under Object type, select Microsoft Graph 97 Chart as shown above. You may have to scroll
down in order to find it.

4. Onceyou have Microsoft Graph 97 Chart highlighted, click OK.
5. Closethe spreadshest if you want to use their data rather than replacing it with your own data.

Inserting a chart

Lesson 8
Part 111
Editing Your Graph
1 In the main menu, click the Chart menu.
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2. You can change the type of graph by selecting Chart Type under the Chart menu.

3D Y.

3. In the Chat Type menu, the Standard Types tab should be selected.
Searetrd Typen | Cuskom Troes |
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4. Pick the Areatype of chart from the left column of options (See bel ow).

5. On the right, you can choose from the Chart sub-type menu. Choose the Stacked Area,
which isthe middle chart in the top row.
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6. If you press down the Press and hold to view sample button, you will see what your graph
will look like.

7. Onceyou have selected atype of graph, click OK.

Creating Slide Transitions

Lesson 9

1. Inthemain menu, click Slide Show.

B e p e Dt Rt Look [ Side S| e e

2. Inthe Slide Show menu, click Side Transition.
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3. The Slide Transition screen should appear. Under Effect, click the down arrow (=) next to
whereit says No Transition.
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4. The transition menu should appear. Click Fade Through Black as shown above. You may
have to scroll down to find it.

5. When you clicked Fade Through Black, the picture on the right side of the screen faded
through black to show what the option looks like. Click the picture to see it again.

6. There are three speeds in the middle of the right side of the screen. Click the bullet next to
Slow as shown below.
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7. Under Advance, click Only on mouse click if it is not already selected. This option will allow
you to click the mouse button to activate the slide transition.

8. Under Sound, click the down arrow ( =) next to [No Sound].
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9. Click Whoosh in the Sound menu as highlighted above.
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10. Click Apply. This will apply the transition we have selected to the slide we are on in our
presentation. Apply to All will cause all of the dides to have this transition.
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Creating a Design Template
Lesson 10

Part |

Defining Design Template A Design Template is a presentation with a consistent
appearance in color and form. A design template has the ending .pot in the file name.
Thistype of file can help give future presentations the same consistent 1ook.

Creating a New Presentation
1. Inthemain menu, click File.
2. Inthe menu that appears, click New.

3. The New Presentation screen should appear. Double-click the Blank Presentation icon
which is highlighted below.

el |i=-rmu|

4. The New Slide screen should appear. Click the Title Slide icon as highlighted below.
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5. Click OK.

6. Thefirst didein your blank presentation should have the boxes displayed below.
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Click to add title

Chek 1o add sub-ttle

Creating a Design Template
Lesson 10

Part 11

Changing the Color Scheme

1. Inthemain menu, click Format.
2. Inthe Format menu, click Slide Color Scheme.
3. IntheColor Scheme screen, click the Custom tab.

4. Click the background color box (awhite box) as shown below.
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5. Click Change Calor.

6. Click the background color you would like to use.

7. Click OK.
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Try using this same technique to change other colors for the presentation. Click the color you
want to change and click Change Color. Remember to click OK to get back to this screen.

Once you are finished editing the colors, click Apply to All. Thistells the computer to use the
color scheme you created for all of the slides in this presentation.
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10. Your current slide now has the new colors that you have specified.

Creating a Design Template
Lesson 10

Part I11

Naming and Saving Your Design Template

1. Whereit saysClick to add title, type My Design Template.

cours ug 2000-2001.doc page 125



Nasri Messarra
Université Saint-Joseph
lundi 3 novembre 2003

ig-!-ou:!-!“-ﬁ-ﬂﬂ-\.'m e e L L L e S L -G-a-":"!-k:-:'-\.'-ﬂ'E
? My Design Template %
&

o S S e e

Click to add sub-title

2. TypeTutorial Color Schemewhereit says Click to add a sub-title.
3. Under the main menu, click File.

4. Under the File menu, click Save as.
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5. The Save As screen should appear. Click the down arrow in the section labeled Save astype.
This section islocated at the bottom of the Save As screen.
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6. Inthemenu that appears, click Presentation Templates[*.pot] as shown above.

7. Double-click the Presentation Designs folder. This allows you to save your design template
with the rest of the already-saved design templates.
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8. Next to File name, type mydesign.pot.
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9. Click Save.
10. Go to the main menu and click File.

11. Inthe menu that appears, click Close.
Creating a Design Template

Lesson 10

Part IV

Applying a Design Template

1. Your previous presentation should now be on the screen. This is the one you used in the
previous lessons. In the main menu, click Format.

2. From the Format screen, click Apply Design as shown below.
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3. In the screen that appears, scoll down until you find mydesign.pot. Click mydesign.pot, and
you will see the slide displayed to the right as shown below.
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4. Click Apply to apply the color scheme used in mydesign to the current presentation.

5. Your current presentation will not lose any of the graphics or text you origionally put in. It
also will not gain any text or additiona dides by applying the design template. The only
change you will see is the choice of colors. All of the background and color choices will
remain consistent through your entire presentation unless you change the color scheme.
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Viewing Your Slides

Lesson 11

There are five different waysto view your slides. So far in this tutorial, we have been
viewing them in slide form. These next forms will show the same slides we have
created in different ways.

Outline Form
1. Under the view menu, select Outline.
B g
ﬁ_
fage Sorten
B tictes Page
EJ s thogy

2. Thisisatext view. The | Thindicates the beginning of the first slide. The number before the
dlide symbol indicates the slide number. Y ou can add text in outline view and it will appear on
your slide.

Slide Sorter

1. Under the view menu, select Slide Sorter. This view alows you to change the order your
slides are presented in.
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2. Click the mouse button on the first slide and hold it down as you move the cursor to the right
until a line appears on the right side of the second dide. Release the mouse button, and the
dlides change places.
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Notes Page
1. Under the view menu, select Notes Page.

2. Here you can add any notes to your presentation that you may need as a presenter but do not
want to appear on the dides. You may want to increase the font size before you type. The

notes screen is areduced view.
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Slide Show

1. Under view, select Slide Show.
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2. The menus and toolbars have disappeared to show a full view of the first dide. Click the left
mouse button once to move to the next slide.

3. To end the dide show, click the right mouse button. In the menu that appears, select End
Show as shown below.

4. Start the slide show again. Press the right mouse button once.

5. In the menu that appears, select pen. You may use this pen as a pointer. If you hold the |eft
mouse button down, it will draw. The markings made by the pen will be erased automatically
at the end of the slide show.

Fricl Grewer
6. Pressthe right mouse button. From the menu, choose End Show.
Putting Y our Presentation on the Web
Lesson 12

Part |
Saving your presentation asHTML
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1. Inthemain menu, click File.

2. IntheFile menu, click SaveasHTML as highlighted below.
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3. The Save as HTML screen should appear. The next few screens will prepare your
presentation for the internet. Thisisthe introduction screen. Click Next.
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4. This screen alows you to choose a layout to apply to your presentation. Click the bullet next
to New layout. Click Next.
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5. Select the page style by clicking the bullet to the left of the word Standard. Click Next.
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6. There are three options for Choose Graphic Type. Gl F graphics often take up more memory
than JPEG graphics, so JPEG is the recommended choice. If you have the PowerPoint
Animation Player, PowerPoint animation graphics will show your animation and dlide
transitions. Since most people do not have the PowerPoint Animation Player, click the bullet
to theleft of JPEG. Click Next.
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7. For monitor resolution, click the bullet to the left of 640 by 480. This will alow even low-
resolution monitors to see your presentation.

8. Under Width of graphics, click the down arrow (*) next to where is says 1/2 width of
screen. In the menu that appears, click Full width of screen. This will make your dides the
size of your screen. Click Next.
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Putting Y our Presentation on the Web
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Lesson 12

Part 1
Saving your presentation asHTML (continued)

1. If you would like your e-mail address, homepage or other information such as the name of
your organization to appear in your presentation, typeit in this screen. Click Next.
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2. Click the bullet to the left of Use Browser Colors. This will alow the colors set on your
browser to be the background and link colors of the page. This does not effect the colors of
your slides. Click Next.
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3. Under Select button style, click the circle button. This is the shape of the navigation buttons
that will appear at the bottom of your prersentation. These buttons will alow you to go from
one side to the next. Click Next.
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4. This screen dlows you to choose where you would like to put your navigation buttons. Find
the icon with the buttons located at the bottom of the screen as shown below. Click the bullet
to theleft of thisicon. Once you are finished, click Next.
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5.

6.
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In the white box under Folder, type in the folder path you would like your presentation to be
saved in. If you are unsure, click Browse to find the folder you are looking for. | am saving
my presentation in the path shown below. Once you are finished, click Next.
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Y ou are finished setting up your presentation, so click Finish.
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Click Don't Save. It is ot neccessary to save the choices we have chosen.
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Putting Y our Presentation on the Web

Lesson 12

Part 111

Viewing your presentation in your browser

1

Close PowerPoint and open your browser such as Netscape or Internet Explorer.

Open your file in your browser. It can be found in the directory you saved it in. Your fileis
not just one document. It is a folder. Open the one which is cdled index.htm. Although the
colors may be different, the page should look like the one displayed below.
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3. Click Click hereto start to begin your presentation.

Post your filesto aWeb site

1. Copy the PPZ (Power Point animation), HTML, and GIF or JPEG files to the same directory
on your server. If you are planning on putting up more than one presentation, make sure you
put filesfor each presentation in separate folders.

2. Addalink from an existing page to the HTML file.
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